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Warranty

ComSonics, Inc. warrants this product to be free of material and workmanship defects for a period of one year
from the original date of shipment.

Remedies provided under Warranty are exclusive and in lieu of all other warranties express or implied. The
liability to ComSonics is limited to product repair or replacement at the discretion of ComSonics. ComSonics
shall not be held liable for any incidental or consequential damages.

The following are not covered by this warranty:

1) Parts or components not supplied by ComSonics, or parts or components that have been modified.
 
2) Any product or part failure that results from accident, abuse, misuse, neglect, or unauthorized repairs or

modifications by individuals other than ComSonics personnel.
 
3) Failures caused by use of this product in extreme climates or moisture conditions.
 
4) WindowLite Installer Battery Pack

Technical Support

ComSonics maintains a Technical Support Service for customer convenience. Should the need arise, contact a
Technical Support Representative by phone at 1-800-336-9681 or 1-540-434-5965; Fax at 1-540-432-9794; or
Email at tech-support@comsonics.com.

Return Information

Products returned for repair, calibration, etc., must be safely packed. Please enclose information on the reason
for return. Ship the material prepaid.

All material in this manual is the property of ComSonics, Inc. and is protected under the United States
copyright law. No material shall be reproduced or used in any form or by any means (graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems) without
the written permission of:

ComSonics, Inc.
1350 Port Republic Road

Post Office Box 1106
Harrisonburg, Virginia 22801  USA

Phone: (540) 434-5965   USA Toll Free: (800) 336-9681
Fax: (540) 434-9847

Email: marketing@comsonics.com
Internet: www.comsonics.com

WindowLite  is a trademark of ComSonics, Inc.

Copyright 1996 - 2000 ComSonics, Inc. Doc No. 100673-003 Rev. A
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Specifications

Operating specifications:
Tuning range 5.00 MHz ~ 860.00 MHz.

Amplitude range -30 dBmV (+30 dBmV) ~ +40 dBmV (99.9 dBmV).

Amplitude accuracy ±1.0 dB at room temperature; ±1.5 dB over operating temperature.

Analog Television Types NTSC / PAL; peak carrier sync, preprogrammed audio offset

Digital Modulation Types QPSK, QPR, QAM, and VSB; bandwidth up to 20 MHz.

Tuning increments Fixed (tuned by pre-loaded tables).

Tuning accuracy Auto-seeking to ≤ 62.5 kHz.

Auto-seeking range ±312 kHz.

(Direct access) quick-tuned
channels

6 channels - user-configurable (factory pre-sets per Country Set).

Step-tuned channels Pre-loaded channel set dependent.

Pre-loaded channel sets 25 standard, picture carrier plus associated sound carrier

Audio Output Frequency modulation detector produces low impedance output to
earphone jack (earphone optional)

Powering specifications:
Battery User rechargeable, 6.0 V @ 0.55 ah.

Battery recharge life > 550 measurements*.

Technical specifications:
Size 7.7” high X 3.5” wide X 2.3” deep (19.6 cm X 8.9 cm X 5.8 cm).

Weight 23 oz. (0.65 kg).

Environmental specifications:
Storage temperature range -20 °F ~ 150 °F (-29 °C ~ 66 °C)

Operating temperature range 0 °F ~ 120°F (-18 °C ~ 49 °C)

Humidity Weather resistant (withstands total immersion into 1 foot of water for
30 minutes without intrusion).

Shock Uniquely rugged.

*Beginning with a new, fully charged battery. Room temperature lab tests produced more than 1,100
measurements by repeatedly activating F1through F6 at 10 second intervals until automatic shut-down
occurred.
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1: Description
The ComSonics WindowLite Installer is the
first signal level meter dedicated to installer
use.  It features the ability to easily choose for
evaluation any one of six pre-selected channels
from the full tuning range available.  The
WindowLite Installer makes measurements on
the chosen channel with a single keystroke,
showing the results on a backlight-capable
liquid crystal display (LCD).

The Installer’s controls have been simplified to
make its operation as easy as possible.  The
keypad has six function keys (F1 through F6),
each capable of tuning a picture carrier fre-
quency and its sound carrier frequency or a
single digital channel in the 5 MHz to 860
MHz range.  It also has arrow keys for single-
step tuning the unit within this range.  There
are keys to control the backlight feature as well
as for powering the unit on and off.  The LCD
features the channel being measured, its level
readout, and the unit of measure.  A light bulb
symbol appears when the backlight is in use; a
battery symbol appears when the battery level
is low.  Unless the battery charge life is nearing
an end, a bar graph shows the relative signal
strength.  When the battery symbol is present,
the bar graph indicates remaining battery life.

1
2
3
4
5
6
7
8
9

10
11
12
13

Input
Lanyard Ring
ABS plastic housing
Tuned channel
Backlight indicator
Level indicator
Units of measure (dBmV or dBµV)
Level strength indicator
Function (channel) keys
Arrow selection keys
Backlight key
Power ON / OFF key
Earphone jack

1

5

3

4

2

8

76

12

11

10

9

13
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2: Power-Up

When first powered-on, Installer is in a low power state to reduce battery consumption.  In
this state, the LCD provides the user with the channel name, units of measure, the last
measured value and a bar graph.  “Backlight” and/or “Battery Low” annunciators may also
appear.

1 The selected channel name in the format [CH XX88 X]. CH for channel, followed
by the channel name comprised of a combination of two alpha-numeric and two
numeric characters. The channel name is followed by P for picture carrier, or S
sound carrier, or A for channels with a second audio channel, or d for a programmed
digital channel. Digital channels are user programmed via a computer program. See
section on Installer Programmer Utility.

2 Battery symbol is illuminated if a battery low condition is sensed.

3 SETUP is illuminated when the User Preference mode is activated.

4 Lightbulb symbol is illuminated if the backlight is active.

5 dBmV or dBµV Units of Measure conforming to internationally used conventions.

6 The bar graph provides a visualization of the measured signal level relative to the
total dynamic range.

-OR-
The bar graph provides a relative indication of the remaining battery life while the
battery low signal is activated.

7 At Power-Up, the measured value displays the level of the last channel measured
prior to power-down.  The display updates with each function keypress.

1 2 3

4

56

7
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3: User Preferences

Three built-in features are available for the user to customize the WindowLite Installer:  the
Country Set, the Unit of Measurement and the selection of six Quick-Tune Measurement
Channels.

One custom user channel line-up set or group can be created and installed to the
WindowLite Installer using the Installer Programmer Utility. The utility is a Windows 95/98
program necessary for the customization and installation of a user defined channel set.
Digital channel definitions can only be installed by use of the utility. See section Installer
Programmer Utility for more details.

User Preferences are made available sequentially to the user through the SETUP mode. In
each sequence, the display blinks, showing current settings. Any displayed setting can be
changed with the arrow keys or left alone; changes are saved automatically.

To enter the SETUP mode, press and hold F6 while powering the unit ON using the
ON/OFF key.

Automatically, WindowLite Installer activates the Country Set Define sequence (described
on page 4). The currently selected Country Set code number blinks.  Arrow keys step
through the sets available (see Appendix B for a complete listing). Pressing F1 leaves this
sequence and initiates the Units of Measure Define sequence.

The Units of Measure Define sequence (described on page 5) of the SETUP mode is indi-
cated by a blinking Units of Measure selection. Pressing either the right or left arrow key
toggles between dBmV and dBµV.  Pressing F2 ends this sequence and activates the Quick-
Tune Channels Define sequence.

The Quick-Tune Channels Define sequence (described on page 6) is the final stage of the
setup mode. F1 through F6 can refer to any six picture/sound carrier pairs contained within
the selected Country Set. At the beginning of the sequence, the channel display blinks,
showing the setting for F1. Press any of the six function keys, and the unit displays the cur-
rent video carrier channel setting. (If the unit has never been programmed, or if a new
Country Set has been selected in the SETUP mode, the factory preset channel for that func-
tion key is displayed.) Use the arrow keys to change the channel setting if desired.  This can
be done for each function key, in any order, and more than once if desired.

End the SETUP mode by pressing ON/OFF; this saves the setup and shuts the unit off.
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3.1: Country Set Define

From a preprogrammed list of countries, the user selects the one best suited to their area by:
(a) placing WindowLite Installer into SETUP mode; (b) keying to the desired Country Set.

•  Country sets are displayed (1 to 25).
•  See Appendix B for a listing of the available countries and their access codes.

Changing the Country Set automatically changes the channel
settings to a default set of channels for that country set.

During this sequence, the Channel Name, Units of Measure,
and the Bar Graph are suppressed from the display.

STEP KEYPRESS RESULTS

1. Power-on WindowLite Installer in SETUP mode; this activates
Country Set Define sequence. The current Country Set code blinks,
indicating that this code can be changed.

2. Scroll through the available country sets:
! scrolls forward (1 to 25, with the standard configuration),
     rolling over to the first set when the last set is passed.
" scrolls backward, rolling over to the last set when the first set
     is passed.

Note: If a user channel set is installed, the country set range is 0 to 25. Set 0 is
the user channel set. See section Installer Programmer Utility for more details.
Important: To reinitialize a country set, scroll forward by at least one number
and then scroll back to the desired country set. The Quick-Tune keys and the
channel center frequencies (learned) are reset to default whenever the county set
is changed.

3. The device continues to the next sequence in the SETUP mode,
Units of Measure Define, described on the next page.

Keys remain inactive during Country Set Define.

Going straight to Step 3 below
without touching "! leaves
current Country Set Define setting
unchanged and continues to the
next sequence in the SETUP mode,
Units of Measure Define.

F6 ON/OFF+

F1

~F2 F6
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3.2: Units of Measure Define

WindowLite Installer makes available two Units of Measure to provide worldwide
measurement compatibility.  The user selects between dBmV and dBµV by: (a) placing
WindowLite Installer into Units of Measure Define mode; (b) choosing between dBmV and
dBµV; and (c) selecting Quick-Tune Channels Define.

During this sequence, the Channel Name, Measured Value, and
the Bar Graph are suppressed from the display.

(continued from previous page)

STEP KEYPRESS RESULTS

The dBmV / dBµV display blinks, indicating that this setting can
be changed.

4. Toggles between dBmV and dBµV. " or ! may be used.

5. The device continues to the next sequence in the SETUP mode,
Quick-Tune Channels Define, described on the next page.

Keys remain inactive during Units of Measure Define.

Going straight to Step 5 leaves
current Units of Measure Define
setting unchanged and continues to
the next sequence in the SETUP
mode, Quick-Tune Channels
Define.

F2

~F3 F6F1 ,
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3.3: Quick-Tune Channels Define
WindowLite Installer’s function keys allow the user to easily tune to one of 6 preselected
channels.  Choices are selected for the key locations by: (a) placing WindowLite Installer
into the SETUP mode; (b) stepping to the Quick-Tune Channels Define sequence; (c)
selecting channel choices; and (d) changing the displayed setting (any change is
automatically stored).

During this sequence, the Measured Value, Units of
Measure, and the Bar Graph are suppressed from the
display.

If the unit has never been programmed (or if a new Country
Set has been entered in the Country Set Define sequence),
the channels displayed in this function will be channel
defaults determined by the Country Set; otherwise the last
channel values programmed for each key will be displayed.

(continued from previous page)

STEP KEYPRESS RESULTS

The Selected Channel setting blinks, displaying the video carrier
setting stored under F1.  NOTE: The display will blink if the
channel has never been tuned before, or is changed here; if the
channel has been previously tuned, it will not blink.

6. Change the channel setting:
! Increments setting from a low channel to a high channel;
" Increments setting from a high channel to a low channel.
No additional keypresses are required to lock a setting. Pressing
" or ! changes and stores the setting simultaneously. If " or !
are not used, the setting is not changed. Changes will be effective at
the next power-up.

7. The display will react as above for the selected function key.

8. Repeat Step 6 for as many function keys as desired.

If you wish to tune a channel at this time, press the function key indicated on the display to
have the Installer search for a center frequency. If the center frequency is found, the F Key
indicator ceases to blink. If the center frequency is not found, the F Key indicator will
continue to blink. (In measurement mode, the center frequency search process takes place
automatically when a channel is selected for the first time.)

9. Ends the SETUP mode and shuts off the unit.

F2or

F3

F6

F1

or or

or

or

F5

F4

ON/OFF
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4: Making Measurements

Each user request for a measurement causes WindowLite Installer to tune to the channel as-
signed to the function key pressed: the Installer displays the picture carrier, and another
press of the same key toggles to the sound carrier, and subsequent keypresses toggle back
and forth between the two. First-time tuning may experience a slightly longer delay than
subsequent measurements as the WindowLite Installer learns and stores the exact location of
the carriers within the channel. (This will happen once for each function key selection; it can
take place here or during the SETUP mode. See Section 3.3, Quick-Tune Channels
Define.)

Several samples of the tuned channel peak amplitude are measured, averaged, augmented
with temperature and characteristic data particular to each instrument, and displayed.  The
value is displayed as the Installer changes to a low power mode. Automatic power down
occurs if a key is not pressed for 1 minute.  Repowering always furnishes the last
measurement made before power-down. The value will be blinking to serve as a reminder
that a previously measured value is being displayed.

                 is also active during normal measurement
operation; automatic power-down occurs if keys remain idle
for 1 minute.

During measurement mode, if the signal is less than
-30 dBmV, the display substitutes LO for the signal level
readout. If the signal level is greater than 40 dBmV, the
display substitutes HI for the signal level readout.

As an additional aid to verification of tuned signals, the Installer produces a low impedance
sound signal, provided through the earphone jack in the Installer’s case. This sound signal is
extracted by the Installer from sound, picture, digital, or other carriers. When a channel is
tuned by pressing an arrow key or one of the function keys, sound can be heard through an
earphone connected to the earphone jack. The sound is turned on 15 seconds for video and
20 seconds for audio. (This is to preserve battery power.)

Signal level measurements are made by (a) powering-on WindowLite Installer, and
(b) selecting the channel to tune: first the picture carrier, then the sound carrier.
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4: Making Measurements
STEP KEYPRESS RESULTS

1. Power-on WindowLite Installer.

2. Requests tuning to pre-defined location, measures value, displays
value of the picture carrier; a second press of the key toggles to the
sound carrier, another press toggles back to the picture carrier.
Pressing F1 for instance, displays the picture carrier of that channel;
pressing F1 again displays the sound carrier; pressing F1 yet again
displays the picture carrier again. (Channels with a second audio
carrier behave differently: see the next page.)

3. Allows tuning from the currently displayed channel to another in
the country set sequence. As each channel has a picture and a sound
carrier channel, the sequence would be picture - sound - picture if
starting from a sound channel, or sound - picture - sound if starting
from a picture channel.

If the Installer displays the picture carrier for Channel 3, for in-
stance, pressing ! displays the sound carrier of Channel 3; pressing
! again displays the picture carrier of Channel 4.  If the Installer
displays the sound carrier for Channel 3, pressing ! displays the
picture carrier of Channel 4; pressing ! yet again displays the
sound carrier of Channel 4.

Similarly, if the Installer displays the picture carrier for Channel 3,
pressing " displays the sound carrier of Channel 2; pressing " yet
again displays the picture carrier of Channel 2. If the Installer
displays the sound carrier of Channel 3, pressing " displays the
picture carrier of Channel 3; pressing " yet again displays the
sound carrier of  Channel 2.

When pressing ! at the upper range, or " at the lower range, the
tuning loops back.  Pressing ! when the Installer displays the
sound carrier of the last channel causes the device to display the
picture carrier of the first channel.  Pressing " when the Installer
displays the picture carrier of the first channel causes the device to
display the sound carrier of the last channel.

ON/OFF

F2or

F3

F6

F1

or or

or

or

F5

F4

!
"

Sound!
"

!
"

Picture Sound!
"

Picture !
""

!
"

Picture Sound!…………….………………

Current
Channel

Next
Channel

Last
Channel

to Last Channel Sound to First Channel Picture

The Installer’s tuning hierarchy

Note:
For user modified chan-
nel sets containing digital
channels, a ‘d’ appears
when a digital channel is
selected. A digital chan-
nel has just one tuning
selection. It does not
have separate picture
and sound carrier meas-
urements. When a digital
channel is selected,
pressing " moves to the
next lower channel or
pressing ! moves to the
next higher channel.
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4: Making Measurements
(Second Audio Carrier Channels)

Some Country Sets include channels with second audio carriers; the keypress sequences for
these channels are different.

STEP KEYPRESS RESULTS

1. Power-on WindowLite Installer.

2. Requests tuning to pre-defined location, measures value, displays
value of the picture carrier; a second press of the key toggles to the
sound carrier, a third press toggles to the second audio carrier, and a
fourth press toggles back to the picture carrier. Pressing F1, for in-
stance, displays the picture carrier of that channel; pressing F1
again displays the sound carrier; pressing F1 yet again displays the
second audio carrier; pressing F1 once more displays the picture
carrier again.

3. Allows tuning from the currently displayed channel to another in
the country set sequence: sound - 2nd audio - picture - sound if
starting from a picture carrier, or 2nd audio - picture - sound - 2nd
audio if starting from a sound carrier, or picture - sound - 2nd audio
- picture if starting from a second audio carrier.

If the Installer displays the picture carrier for Channel 3, for in-
stance, pressing ! displays the sound carrier of Channel 3; pressing
! again displays the second audio carrier of Channel 3; pressing !
again displays the picture carrier of Channel 4.  If the Installer
displays the sound carrier for Channel 3, pressing ! displays the
second audio carrier of  Channel 3; pressing ! displays the picture
carrier of Channel 4; pressing ! yet again displays the sound
carrier of Channel 4.

Similarly, if the Installer displays the picture carrier for Channel 3,
pressing " displays the second audio carrier of Channel 2; pressing
" again displays the sound carrier of Channel 2; pressing " yet
again displays the picture carrier of Channel 2.  If the Installer dis-
plays the sound carrier of Channel 3, pressing " displays the
picture carrier of Channel 3; pressing " yet again displays the
second audio carrier of  Channel 2; pressing " yet again displays
the sound carrier of  Channel 2.

ON/OFF

F2or

F3

F6

F1

or or

or

or

F5

F4

Current
Channel

Next
Channel

Last
Channel

to Last Channel Second Audio to First Channel Picture

The Installer’s tuning hierarchy for channels with a second audio carrier

!
"

Sound!
"

!
"

Picture Sound!
"

Picture
"

……..2nd Audio!
"

2nd Audio!
"

!
"

Picture Sound!
"

!
"

2nd Audio!

Note:
For user modified chan-
nel sets containing digital
channels, a ‘d’ appears
when a digital channel is
selected. A digital chan-
nel has just one tuning
selection. It does not
have separate picture
and sound carrier meas-
urements. When a digital
channel is selected,
pressing " moves to the
next lower channel or
pressing ! moves to the
next higher channel.
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5: Backlight

As a standard feature, the LCD is provided with a backlight to enable the instrument’s use in
low lighting conditions. Backlights require extra power and will significantly reduce avail-
able battery life.

The WindowLite Installer features automatic backlight deactivation and reactivation at stra-
tegic points during normal use. Pressing the LIGHT key illuminates the backlight. After 10
seconds, the backlight automatically deactivates.  After deactivation and prior to power-
down, the backlight will reactivate with each function keypress as well as with the LIGHT
key, automatically deactivating 10 seconds after each keypress. When the backlight is on,
pressing the LIGHT key turns the backlight off.
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6: Battery Care

The Installer uses a rechargeable battery.  For recharging this battery, ComSonics includes a
single-unit battery charger as a standard accessory.

The single-unit charger’s contact end (see illustration) consists of a yellow plastic housing,
with flanges on either side, and two spring-loaded prongs.  It fits into the slot on the bottom
edge of the Installer, which has contacts corresponding to the charger prongs (see
illustration).

Prongs of a single-unit charger Contact end of Installer unit and points

To engage the contacts properly, hold the Installer face up, place the yellow housing so the
flanges fit into the corresponding grooves in the Installer unit’s contact end, and push to-
wards the front of the Installer. When the housing is completely inserted, the prongs will be
in contact with the Installer’s contact points. Plug in the charger to begin recharging your
Installer. Fully recharging a depleted battery takes approximately 10 to 16 hours.

When the battery charge drops below a set level, the battery low indicator (      ) appears.
The bar graph of the display blinks while this indicator is present, and shows the relative
amount of charge remaining.
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6: Battery Care (cont.)
Eventually, repeated depletion and recharging of the battery will decrease the battery’s effi-
ciency and require its replacement. Care must be taken when replacing the battery so as to
maintain the Installer’s waterproof seal. The following instructions have been provided to
make this possible.

1. With the back of the Installer facing up, remove the screws from the casing. The
battery is attached to the back of the unit by a metal bar (see below).

2. Remove the screws holding the metal bar over the battery and remove the bar.

3. Detach the battery’s two-pin Methode connector and remove the battery. Discard
properly.

4. Put the new battery in place and attach its two-pin Methode connector. Be sure to
insert the connector correctly; the connector should not have to be forced on.

5. Place the metal bar over the battery and replace the screws. Note that the bar is
placed under the black battery wire as pictured below.

6. Replace the casing, making sure
that none of the internal cables
are pinched between the rubber
pads and the Installer’s internal
parts.

7. Replace the screws, in the order
shown.

Back

Front

To Close the Unit:

1. Loosely reinstall the screws.
Tighten to 2 inch pounds in
this order; 1,2,3,4,5,6.

2. Once all screws are in place,
tighten them to a final torque
of 4 inch pounds in 1,2,3,4,5,6
order.

3. Take care NOT to pinch any
wires.

The battery is attached to the
back of the unit with a metal
bar. Some battery models,
because of the location of the
lead, require the lead to be
placed over the bar in order to
close the unit properly.
Battery may be different from
pack shown.
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Appendix A: Keypress Reference

KEYPRESS ACTIVITY or RESULTS

Toggles Installer on and off.

Quick-Tune Selection 1: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Quick-Tune Selection 2: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Quick-Tune Selection 3: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Quick-Tune Selection 4: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Quick-Tune Selection 5: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Quick-Tune Selection 6: defaults to picture carrier; press again
for sound carrier, press again to return to picture carrier*

Arrow Keys for channel selection by scrolling.

If tuned to a picture carrier, tunes to the sound carrier of the
current channel; if tuned to a sound carrier, tunes to the (next
higher) adjacent channel’s picture carrier†

If tuned to a picture carrier, tunes to the (next lower) adjacent
channel’s sound carrier; if tuned to a sound carrier, tunes to
the picture carrier of the current channel‡

Toggles LCD backlight on and off.

Activates SETUP mode

Changes Country Set

Changes Units of Measure

Changes Quick-Tune channel settings

*  If using a Country Set with channels with second audio carriers: the first keypress defaults to picture carrier; press
again for sound carrier, press again for second audio carrier, press again to return to picture carrier. See 4: Making
Measurements.
†  If using a Country Set with channels with second audio carriers: if tuned to a picture carrier, tunes to the sound car-
rier of the current channel; if tuned to a sound carrier, tunes to the second audio carrier of the current channel; if tuned to
a second audio carrier, tunes to the (next higher) adjacent channel’s picture carrier.
‡  If using a Country Set with channels with second audio carriers: if tuned to a picture carrier, tunes to the (next lower)
adjacent channel’s second audio carrier; if tuned to a sound carrier, tunes to the picture carrier of the current channel; if
tuned to a second audio carrier, tunes to the sound carrier of the current channel.

ON/OFF

F2

F3

F6

F1

F5

F4

+F6 ON/OFF

,+F6 ON/OFF

,+F6 ON/OFF F1 ,

, ~,+F6 ON/OFF F1 , F2 F1 F6 ,

LIGHT
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Appendix B: Channel Line-Up Set and Country Set Codes

CODE NAME

0 Custom User Set
1 US STD EIA
2 US HRC EIA
3 US IRC EIA
4 Australia
5 BCST US (US Off Air)
6 Belgium
7 Canada
8 China
9 Denmark

10 France
11 Germany
12 Hong Kong
13 India
14 Israel
15 Japan
16 Korea
17 New Zealand
18 Netherlands 1
19 Netherlands 2
20 Poland
21 Sweden
22 Switzerland
23 Taiwan
24 United Kingdom 1
25 United Kingdom 2

Country Set Codes 1 through 25 are included in the Installer Programmer Utility as factory
default channel groups. Use the utility to view the details of factory groups and to modify a
factory group, including the addition of digital channels. Save the modified group under a
new user name and send it to the WidowLite Installer. The new user group is Country Set
Code 0. Factory Channel Set Groups are protected and can not be modified. See section
Installer Programmer Utility for more details.
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Appendix C: Pressure Relief

The Installer case is sealed against water.
Because of this seal, taking the Installer to
extremes of air pressure (e.g., from sea level
to a very high elevation) may cause air
pockets within the keypad. To alleviate this,
the Installer is fitted with a pressure relief
“valve”: a Phillips screw directly beneath the
label on the back of the unit.

Loosen the screw a few turns and wait five
minutes for the air pressure within the unit to
equalize.

Do not forget to re-tighten the
screw after performing this action!!
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Appendix D: European Community Declaration of Conformity

Manufacturer: ComSonics, Inc.
P.O. Box 1106
1350 Port Republic Road
Harrisonburg, VA  USA 22801
Tel. #  540-434-5965

Product: WindowLite™ Installer
Models: 100671-001, 100671-002, 100671-003

ComSonics, Inc. of Harrisonburg, Virginia, USA, hereby declares that the above-referenced
product, to which this declaration relates, is in conformity with the provisions of:

Council Directive 89/336/EEC (May 3, 1989), on Electromagnetic Compatibility, as
amended by Council Directive 92/31/EEC (April 28, 1992), and

Council Directive 73/23/EEC (February 19, 1973), on Low Voltage.

The Technical File required by these directives, including the original of this Declaration of
Conformity,  are maintained at the corporate headquarters of ComSonics, Inc. (as listed
above) and within the European Community at ComTec Cable Accessories, Ltd., Over
Industrial Park, Over, Cambridge CB4 5QE, United Kingdom.

Exceptions noted to the above: None
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Appendix E: Installer Programmer Utility

The Installer Programmer Utility is a Windows 95/98 program necessary for the
customization and installation of a user defined channel line-up set or group. Digital channel
definitions can only be installed by use of the utility. A special interface cable is used with a
standard DB-25 serial communications port. An adapter may be needed (not supplied) for
computers with DB-9 ports. Only one user defined group can reside in the Installer. It is
selected in the Installer by choosing country set 0. See section 3.1: Country Set Define.

Install Programmer Utility
Place the CD-ROM into the drive. The installation program will automatically start.
If the PC auto-start function is turned off, follow the instructions below to manually
install the program.
Manual Install:
Click Start, then click Run. Type D:\SETUP (If your CD-ROM drive is not D,
substitute with your drive letter) or choose Browse and select your drive, then select
SETUP.EXE. Click OK and follow on-screen instructions.

Run Programmer Utility
Double-click the desktop icon to start the Utility.
or
From the Program list, move the pointer to Programmer Utility. Then click on
Programmer Utility.

Select a Channel Group
From the File Menu select Open. Click on the selected group. Click OK.
or
From the File Menu select Import. A properly formatted text file can be imported,
modified, and saved as a group. Select the text file to import and click on Open.

Note: For a sample of the format needed for an import file,
open a copy of a factory default group in a text editor
program.
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Modify the Channel Group
From the Edit Menu or by use of the Command Buttons select and modify these
properties.

•  Group Information
•  Function Key (Quick-Tune) Channels
•  Add Channel
•  Delete Channel
•  Modify Channel
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Save the Channel Group
From the File Menu select Save Group As to rename the group. Modified factory
default groups must be renamed. If the current group is a user group and is to be
saved under the same name, select Save Group.

Print the Channel Group Information
From the File Menu select Print. A tabular listing of the current group is sent to the
default printer.

Send Group to Unit
From the File Menu select Setup Comm Port. Select the proper communications port
and click OK.
Connect the communications cable and power on the WindowLite Installer while
holding the F1 key. SL and CL appear on the Installer’s display.
From the Tools Menu select Send Group to Unit.
Groups containing: digital channel descriptions, more than 128 channels, or analog
dB offsets will not load into non-digital units.

Modify Group List
From the Tools Menu select Modify Group List. Select the group to remove and
click Delete Group.
Only user defined groups are listed. Factory default groups are protected and can not
be deleted.

Exit WindowLite Programmer Utility
From the File Menu select Exit.
or
Click the Close button in the upper right corner of the display.

Access Installed Channel Group
With the WindowLite Installer off, press and hold F6 while powering the unit on.
Press an arrow key to select country set 0.

Important: If the Installer was on country set 0 during the installation, scroll to
country set 1 and then back to country set 0 to properly load the new set.

Power the unit off.
The installed channel group is active on the next power-up.
See Section 3.1: Country Set Define for detailed instructions.




